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Release 1 Overview
Knowledge is power and with Intacct 2017 Release 1, we’re excited to introduce two important features to
our Spend Management module that enable you to use that power in considering and validating
expenditures against budget:



You can include committed, but not-yet-made, expenditures recorded in user-defined books when
you validate a purchase requisition against a budget. The result? The actual budget available after
monies spent and funds committed are subtracted.
You can get spending insight into how a purchase requisition fits (or doesn’t fit) into budget totals,
expenditures, and remaining budget at the time of requisition creation. You can make adjustments
to the requisition based on the budget, or adjust the budget to include the purchase—all before you
ever post.

More release features
Purchasing
 Purchasing approvals that fit your business -- we added new value approval rule types that provide
more choices for routing based on the amount, with the flexibility to route approvals based on each
department's needs
 Additionally, you can now approve directly from purchasing transactions. And, to help you make
approval decisions, you can check transaction details more easily from an enlarged viewing space.
Salesforce integration for Contracts
 Contract Billing for CRM -- the first product built on our new Salesforce connector supports contract
creation and management from within your Salesforce application.
 Redesigned from the ground up, the integration supports new Contract capabilities plus additional
enhancements and features that strengthen the integration between Salesforce and Intacct.
Projects
 Better invoice insights -- we increased the visibility of transaction dates and notes in Order Entry
transaction pages. Now you can easily identify line items by viewing the associated timesheet notes
and transaction dates for timesheets, expenses, AP bills, PO vendor invoices and sales orders. For
example, you can check the detail in a line item to determine how many days a resource actually
worked or the date of a billable expense.
 Improved visibility and reporting on tasks when used as an alias for Class -- If you repurpose the
Class dimension for tasks, and then auto-populate the Class field with the task name, the system
now automatically displays the task description on the Class Information page.
Inventory
 More validation, better data – Improvements for transactions involving inventory -- To help you
reduce errors in calculating items costs and improve the accuracy of your financial reporting, we
make sure that you enter non-negative values in the Quantity and Price fields for inventory items.
 On order and on hold quantities – no more double counting of on-order or on-hold quantities when
you partially convert transactions with multiple lines of inventory items.
 Ensure inventory costs are up to date -- with this release you can recalculate the cost of inventory
items that use the average cost method, eliminating costing problems that can arise, such as when
transactions aren't entered in transaction date order.

Spend Management: now get Spend Insight and include committed expenses
Keeping track of spending is crucial to any organization. It can be difficult, if not impossible, to oversee all
expenditures across the organization because expenditures can come from many different processes, such
as purchase requests, staff expenses, bills, direct payments, and more. Recently, we introduced Spend
Management to help you track expenditures, validate expenditures against your budget, and ensure that
any overspending is based on solid business decisions. Since then, we've been working to enhance Spend
Management, adding useful features to make staying within your budget more efficient. Here are two new
features that improve Spend Management.
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Include committed expenses in the validation process
Organizations often have budgeted funds that are committed but not yet spent. For example, Not-forProfits put money aside for fund raisers, and commercial organizations often plan for trade shows that can
be years away. Spend Management can include these committed expenditures in user-defined books that
you create to track and release committed funds. These funds are then included when Spend Management
validates a purchase requisition against a budget. This allows Spend Management to determine how much
of your budget remains, based on what you've already spent, and what you've committed to spend.
Spend Insight: See budget totals, expenditures, and remaining budget when you create
Purchase Requisitions
As an admin you can see the budget, what's been spent, and remaining totals right on the Purchasing
requisition page. You now have insight into how this purchase requisition fits (or doesn't fit) into the
budget. That insight speeds up the whole approval and posting process. Make adjustments to the
requisition based on the budget, or choose to make or request budget adjustments, all before you even
post!
To take advantage of Spend Insight:
1.
2.
3.
4.

Make sure Spend Management is configured for your company, and that the budget is in place.
Within the Purchasing application, open a purchase requisition or create a new one.
Before posting, click Show Spend Insight, located above the Entries section.
From the Spend Insight dialog box, you can see all of the pertinent information about the purchase
requisition and how it fits into the budget. Spend Insight displays budget impact by line item. If
you add a new line item, best practice is to recheck with Spend Insight.

1099 enhancements added to T&E
Last release, among other 1099 enhancements, we enabled you to change the 1099 status of a vendor
and have the system automatically update all transactions associated with that vendor, and we enabled
you to override the 1099 form and box at the line level in AP transactions. We recently extended those
features to employees and employee expenses.
1099 Contractor employees


Override the form and box for a specific expense line item

Prerequisite: Configure your T&E application to enable overriding the 1099 form and box at the lineitem level.
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Now you can select a different form and box per line item.



Change the employee 1099 status and leave the rest to us -- If you need to add or remove
eligibility for an employee contractor, you no longer need to export all affected expense reports,
then import them again with the changed status. After you change an employee status, we'll ask
you if you want to change all the associated expense transactions. If you say OK, consider it done.

And, you can still use the old import method, as needed. For example, you might want to import via a
CSV file if you have multiple employees with expenses that require a status change.

Import daily exchange rates in a snap
Sometimes multi-currency companies want to add multiple exchange rates for their company. Once, this
was a tedious manual process, but no longer. We added the ability to import large quantities of historical
daily exchange rates from a template, making it much more efficient than manually entering rates one at
a time. Import rates via CSV or the Web Services API.
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To import multiple custom daily exchange rates:
1. Get the Exchange Rates template. Go to the Company Setup Checklist and download the
template from Exchange Rates.
2. Enter all of the exchange rate information, one exchange rate per line, and save your file. The
exchange rate type must already exist in your company setup. If it doesn't, create the exchange
rate type first, or leave it blank to use the Custom exchange rate.
3. In Exchange rates (from the Company menu) click the Import Exchange Rates button.
4. Select your completed template.
5. Click OK.

Quicker access when importing GL journal entries
You've always been able to import your General Ledger journal and statistical entries from a .csv file,
saving time and lowering the possibility of errors when you input large numbers of journal entries. We
made it easier to import entries to GAAP, Tax, user-defined books, adjusting entries, and statistical
adjusting journals by adding an Import transactions button right on the page.
To import journal entries:
1. Just like you always could, you download the Journal Entries or Statistical Journal Entries
template from the Company setup checklist.
2. Prepare the file to import.
3. Open the list for the entries you want to import (GAAP, Tax, user-defined, adjusting entries, or
statistical adjusting) and click Import transactions at the top right of the page.
4. Select the .csv file containing the entries and set any other options.
5. Click Import.

Introducing the Intacct Help Center
We've updated the Help menu and unveiled a brand new Help Center. The purpose? Getting you the
information you need, anytime and anywhere.
Streamlined Help menu



As always, you can get targeted information on any page by choosing Help on this page.
Have a question about something else? Visit the Help Center!
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Help Center--everything on one screen



Need answers fast? Searching the Help system is the way to go. We'll serve up relevant help topics
based on the phrase or question you enter.
Need more? The resources at the bottom of the page will get you on the right path.

Want to browse by subject area? Use the fly-out menu at the upper right of the Help Center to access
an expanded list of help topics.
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Approve purchasing transactions directly from the transaction
Need to approve purchasing transactions? Approving just got easier with these enhancements:



More space to view transaction details. When you view a transaction to verify the details, the
transaction opens in a larger window, reducing the need to resize or scroll.
The ability to approve or decline directly from within the transaction and optionally add a comment.
With the Approve and Decline buttons we added, you no longer have to close the transaction, go
back to the list of transactions waiting your approval, and approve or decline the transaction from
that list.

Contract Billing for CRM
Contract Billing for CRM is our first product built on our next generation Salesforce connector, Intacct
Advanced CRM Integration. Contract Billing for CRM adds true multi-channel support for contract creation
and management from within your Salesforce organization. With this automated solution, your duplicate
data entry is eliminated, and you can now provide your sales team with financial insight into their sales
activity.
Our existing Contract capabilities provides your organization with:
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Flexible pricing structures
Support for tiered and usage base pricing models
Allows for customizable billing schedules, and
Enables compliance with ASC 606 revenue recognition rules

Contract Billing for CRM uses the standard Salesforce Contract, which are linked to Opportunities.
The Intacct Advanced CRM Integration combines the best of Salesforce and Intacct. It was redesigned
from the ground up, incorporating enhancements and feedback from hundreds of companies using our
current Salesforce solutions.
The Intacct Advanced CRM Integration offers you:






Simplified setup
Centralized user management
Real synchronization, including contact synchronization
Improved custom field mapping capabilities
And, as a managed package, the ability to receive new features and updates with Intacct feature
releases

Intacct Contract Billing for CRM and Advanced CRM Integration can be used with Salesforce Enterprise,
Unlimited, and Performance editions. They both are Salesforce Lightning Certified, and also work in the
Classic Salesforce user interface.

More things to see on the audit trail
It’s always important to know how something will impact your financial statements. Intacct has updated
the audit trail to show more information and allow you access to the audit trail through a custom report.
When you view the audit trail in the Intacct UI, it now includes (for most events):




The name of the field that was changed
The value of the field before it was changed
The new value of the field after the change

You can also create a custom report for the audit trail using the data source Audit History. This allows you
to run a report showing all the changes in your company, which you can then sort by time, user, or object
that was changed. You must have admin access to Intacct to use this aspect of the audit trail.

Use 2-step verification and single sign-on simultaneously
For our SSO users - you can now enable your company for SSO and 2-step verification simultaneously.
SSO and 2-step verification work together to provide you with seamless security. While most of your users
use your SSO solution for login, you may have a business need for some users to sign-in to Intacct
directly. A good example is if your SSO system was temporarily unavailable, your Intacct admin may need
to sign-in to Intacct.
Now, you can configure both methods for your company, with 2-step providing extra security for direct
sign-in access.
Note: If your company uses SSO, we recommend configuring your SSO implementation to use an extra
layer of protection, for example, 2-step verification. This means configuring your SSO instance to require
a verification code before you can access your business applications through your SSO login.

Whitelist domains for flexibility and security
Maybe you use a security software plugin, like Trusteer Rapport, or maybe you use another plug-in which
might interfere with Intacct.
Page 9 of 18

We've added the option to whitelist domains and define your own content security policy. In Company >
Company information, on the Security tab, administrators can whitelist trusted domains at the
company level.

Better invoice insight with included timesheet notes and dates
Reviewing project billings invoices can be a tedious task when you have to track down transaction
information. To make things easier, we've increased the visibility of transaction dates and notes in Order
Entry transaction pages. Now you can easily identify line-items by viewing the associated timesheet notes
and transaction dates for timesheets, expenses, AP bills, PO vendor invoices, and Sales Orders. Just click
the Show Details tab in any Order Entry transaction page to view, for example, the days a resource
actually worked, or the date of the billable expense.
To view the two new fields in an Order Entry transaction page:
1. Go to Order Entry > Invoice > [Order Entry transaction] > [Add/Edit].
2. In the Entries section, click the Show Details tab.
3. In the Details section, you'll see two new fields, Transaction Date and Timesheet Notes.
Tip: You can drag-and-drop the two fields in the Show Details tab onto the Entries table above for
immediate visibility.
What's more, you can also configure your Projects application to automatically default the timesheet note
to display the task description. This helps surface task information to the invoice level where you can
easily approve and review invoice line-items. In addition, this provides visibility for customers who see
timesheet notes on their invoice.

Another insight feature we've added this release is the ability to include the actual billings of a project on
custom documents and custom invoices. Just use the Word Merge tool to add the field for increased
visibility for you and your customer into project billings.
1. Go to Order Entry > Open Setup > Transaction Definitions > [Add/Edit].
Page 10 of 18

2. On the Transaction Definition page, in the Print section, select a Document Template and select
Enable display of actual billings on printed and emailed invoices.
3. Click Save.
4. Create or edit a custom document (Customization Services or Platform Services > Custom
Documents > [Add/Edit]).
5. Use the Word Merge tool to add the field PROJECT_ACTUALBILLINGS to your invoice.
6. Create the invoice as usual.
Note: Billing children projects with the parent? The actual billings on the invoice will include amounts
from both the parent and children projects.

Improved visibility and reporting on Tasks when used as alias for Class
You spoke and we listened. For users who re-purpose the class dimension with task, and auto-populate
the Class field with the Task name, we have good news. The class Name on the Class Information page
will now automatically default to the Task description. You'll get more visibility, especially when it's time to
create or run financial reports using the class Name field.
For example, you may have a task you're using as a class called "Training." You enter a description
"Training and support." Instead of the generic term "Task" appearing in the Name column on the Classes
page, the custom description you entered appears instead.

More validation, better data – Improvements for transactions involving
inventory
The Intacct system gives you a lot of flexibility, which in a few cases can create unexpected effects that
you might not be aware of. For example, you've been able to enter a negative value in the Quantity and
Price fields for order entry, purchasing, and inventory transactions. However, entering negative values can
cause issues with tracking costs.
Starting with this release, you can enter only non-negative values in the Quantity and Price fields for
inventory items, kits, and stockable kits. (You can still enter negative values for non-inventory items,
sales-only items, and purchase-only items.)
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Non-negative values will reduce errors in calculating item costs and improve the accuracy of your financial
reporting, allowing you to make better decisions about managing and driving the profitability of your
business.
To reduce the quantity of items, use order entry, purchasing, and inventory transactions that have an
appropriate transaction definition that subtracts quantity. For example, if you need to reduce quantity
because a customer returned items, use a sales return transaction.

On Order and On Hold quantities - no more double counting
Do you partially convert transactions that have multiple lines of inventory items that effect On Order or On
Hold quantities? Previous to this release, unconverted On Order and On Hold quantities would show up on
both the original transaction and the newly created backorder transaction with the quantities being
counted twice in reports. Now, we've fixed that, so that you'll know exactly what inventory items are
available in your warehouses.
Let's go through an example. Assume your transaction definition for Purchase Orders is configured for
Close Original and Create Back Order.
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Ensure your inventory costs are up-to-date
Insight into inventory costs is crucial for managing your business profitability. While not common, costing
problems can arise, particularly when transactions aren't entered in transaction-date order. So, we've
introduced the ability to recalculate inventory costs to ensure your reports and financial statements reflect
a more accurate picture. With this release, you can recalculate costs for inventory items that use the
average cost method.
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When you recalculate inventory costs, the Intacct system runs a process that:



Recalculates the costs using all of the relevant transactions (purchase, sales, adjustments, and
returns), processing them in transaction-date order. You specify which costs are recalculated:
inventory valuation, current item costs, and costs of goods sold (COGS).
Generates CSV files that highlight where the recalculated costs differ from the originally recorded
costs.

This process differs slightly depending on whether you recalculate costs with the Analyze or Update
option. While the costs are always recalculated with either option, the costs are only changed and brought
up to date with the Update option. Therefore, we recommend that you follow this 2-step process to track
down and resolve costing issues:

When you analyze the costs, any issues with negative inventory are also flagged. You can choose to fix
those issues, using techniques such as back-dating purchase orders, before you go ahead and update the
costs.
A good time to analyze and update inventory costs is when you're ready to close a period, because all of
the transactions have been entered. You can start the new period knowing that your costs are up-to-date.
To assess inventory costing issues:
1. Go to Inventory Control > Recalculate Inventory Costs, and then click Add.
2. Enter the information about the costs you want to recalculate. The system looks at transactions
and recalculates the selected inventory costs starting from the Recalculate from date.
3. Click Analyze costs. The system runs a process to recalculate the costs and generate CSV files
with the results.
4. Download and review the CSV files. Use the information to assess the impact of updating
inaccurate costs and decide if you want to fix any problems with negative inventory before
updating the costs.
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To change your inventory costs:
1. Go to Inventory Control > Recalculate Inventory Costs, and then click Add.
2. Enter the information about the costs you want to update. The system looks at transactions and
recalculates the selected inventory costs starting from the Recalculate from date. (Tip: Use the
same Recalculate from date that you used when you analyzed the costs.) The system updates
inaccurate costs starting from the Update start date.
3. Click Update costs. The system runs a process to recalculate the costs, update inaccurate costs,
and generates CSV files with the results. To update inaccurate COGS, the system re-posts
historical transactions to the General Ledger using the recalculated COGS.
4. Review the CSV files to ensure the costs are updated the way you anticipated.

Reclassify transactions in your IGC company
Reclassifying a transaction enables you to change how expenses or revenues for that transaction are
assigned. You can update almost anything on a bill or invoice, except for the amount and the payment
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date. For example, if the transaction was assigned to the wrong department, you can choose a different
department.
Recently, we extended the ability to reclassify transactions in AP and AR to the top level of Intacct Global
Consolidation (IGC) companies that use the same base and transaction currency.
Reclassification works in the top level of IGC companies just as it works in single entities, and with the
same rules. You can reclassify a full or partially paid transaction when the appropriate application
configuration and user permissions are enabled, and no limiting conditions exist that would preclude
reclassification, such as associated allocation periods, or linked revenue recognition.
Real-world example of a need for top-level IGC reclassification:
You are an IGC company who processes bills and invoices from the top level of your company. Tax time is
upon you and you realize that one line item in a multi-line vendor transaction should have been set as a
different form and box type.
Solution:
1.
2.
3.
4.
5.

Go to the transaction, and click Reclassify.
Click in the line item, then click Show details. The line-item detail area opens.
Select the correct form from the Form 1099 Type drop-down.
Select the relevant box from the Form 1099 Box drop-down.
Click Post.

Formats for more professional looking financial reports
Three formatting options enable you to give a more polished look to your financial reports.
Hide filter details in the column heading
Many organizations filter reports by account group or dimension structure to create one report for multiple
audiences. However, sometimes knowing the item you've filtered on isn't important to the person viewing
the report. In this case you can hide the filter details in the column headers.
To hide filter details:
1. Open or create the financial report, then go to the Format tab. The page opens to the General
tab.
2. Tab to Page Setup & Columns.
3. Scroll to the Column options and fonts section.
4. Enable Hide filter details on column titles.
The filtering details don't appear on column titles when the report is generated, and works with all output
formats.

Hide the budget name
When a budget is selected for a Budget column in a financial report, the budget name is used as the
column title, but sometimes you don't want report recipients to see this budget information. You can enter
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a different title for the column, but until now you couldn't leave the column title blank: the system would
automatically re-include the budget name.
Now you can. Beginning immediately, if you leave the title blank, the column title stays blank. It's still
possible to use a different title, if you choose, by typing in the new title. If you leave the title blank, but
change your mind, all you need to do is to re-select the budget and the budget name is once again set to
the column title.
Appearance of negative numbers
You've always been able to choose how you want negative numbers to appear in reports, but as part of
our continuing improvements we moved the negative numbers setting from the Font Size table in the
Pages & Columns tab, and one notable change was made. In order to improve report formatting and
ensure that column alignment when negative numbers are included, you're limited to setting how the
numbers are displayed. Using a different font or font size is no longer supported for negative numbers.
To set the negative number format:
1. Open or create the financial report, then go to the Format tab. The page opens to General
formatting.
2. In the Numbers section, locate Negative numbers to define the way that negative numbers
appear in the report. For example, you might use a leading minus sign (-) or enclose it in
parentheses.
3. For PDF reports only, set the negative numbers color from the drop-down list.

Better community collaboration for developers in the Intacct Community
The developer forums at developer.intacct.com have helped many developers over the past five years, but
it's time for something even better. The Intacct Developers group is now available inside the Intacct
Community! The current forums at developer.intacct.com will become read-only at the end of February, so
start using the new Intacct Developers group today!
The new group is designed to encourage more collaboration between developers and to provide tighter
integration with Intacct systems. From one system you can:




Post questions for other developers to answer, or add responses of your own
Search knowledge base articles
Log or view support cases

To join the Intacct Developers group on the Community:
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1. Sign into the Intacct Community. (Tip: If you’re not already a member, click Get Started on the
left side of the page to join up).
2. Click the Connect tab.
3. Click Active Groups.
4. Type “Dev” in the search field, then choose Intacct Developers from the list.
5. Click Join.
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